Advanced Typography with Mac OS X

Using and Managing Fonts

Technology Tour
July 2004
Contents

Page 3  Introduction
What’s New in Panther: The Highlights

Page 5  New Font Features in Panther
Font Book
Font Panel
Character Palette

Page 9  Font Management
Mac OS X Font Locations
Classic Fonts and Applications
Server-Based Fonts
Managing Fonts with Font Book
Organizing Fonts for a Third-Party Font Manager

Page 21 Optimizing a Production System
Removing or Deactivating Nonessential Fonts
Font Management for Prepress and Production

Page 27 Appendix A: Additional Resources

Page 29 Appendix B: Mac OS X Fonts

Page 31 Appendix C: Font Support in Mac OS X

Page 32 Appendix D: Font Locations in Mac OS X

Page 34 Appendix E: International Language Support
Introduction

Whether you’re producing sophisticated type effects for print layouts or selecting an easy-on-the-eyes font for online readers, you know how crucial typography is for successful visual communications. Recognizing this fact, Apple has made typography a top priority in every Macintosh operating system from the very beginning. More than any other platform, Mac OS X gives you exceptional creative options for typography and makes your fonts easy to access and manage.

With Mac OS X version 10.3 “Panther,” Apple has set a new benchmark for desktop typography. High-fidelity rendering both on screen and in print makes Panther the most visually rich and consistent typography platform available today. Because it’s built on the Quartz graphic rendering engine, Mac OS X allows you to do more with fonts than ever before. You can manage fonts, create unlimited collections, use any font format, and modify fonts for perfect typography—all with ready-to-use Mac OS X tools. Mac OS X v10.3 also includes more than 100 fonts—28 for different languages—giving you more creative leeway and making it easier to create materials for international consumption.

Advanced typographical capabilities in Mac OS X v10.3 remove the barriers to creativity and give you the freedom to get your job done with exceptional flair and ease.

What’s New in Panther: The Highlights

When it comes to typography, Panther has a number of options to help you make your creative vision a reality:

**No limits.** There are no font limits in Mac OS X. You can place an entire font library in a single folder and use it. Virtual memory in Mac OS X simply draws on more memory when necessary.

**More fonts.** Mac OS X v10.3 includes more than 100 fonts and supports more non-Roman languages and bidirectional fonts than ever before.

**Richer font support.** For more predictable cross-platform and cross-media publishing, Mac OS X supports all of the major font formats, including PostScript Type 1 (with the double-byte PostScript fonts required for non-Roman languages), Multiple Master, Windows TrueType, and OpenType—the font format of the future.

**Font Book.** New to Mac OS X v10.3 is the versatile Font Book application for finding and managing fonts from a single, central location. Managing fonts in Mac OS X is now as easy as managing songs in iTunes or images in iPhoto.
Smother fonts. Thanks to its underlying Quartz technology, Mac OS X makes text beautiful and easy to read on all displays. A setting in the Appearance system preference lets you select one of four font-smoothing styles to increase onscreen readability: Standard (best for CRT displays), Light, Medium (best for flat-panel displays), and Strong. Sophisticated font-rendering technology with subpixel filtering also increases effective resolution when fonts are displayed.

Professional typography. Sophisticated typographic capabilities such as kerning and tracking are no longer limited to professional layout applications. Mac OS X supports Apple Advanced Typography (AAT) at the system level, so even basic applications such as TextEdit can take advantage of advanced typographical features, including glyphs.

A glyph can be a single character or a series of characters (a ligature). The “pf” is a ligature, and the entire font name Zapfino is a single glyph. Notice the different letterforms—how the “p” changes when followed by “f,” and how each of the letterforms changes in the final glyph.

Advanced font rendering. Apple Type Services (ATS), a key element of the Quartz graphics and imaging system in Mac OS X, provides resolution-independent font handling, anti-aliasing, and special anti-aliasing algorithms for LCD screens. ATS allows third-party developers to build sophisticated typography features into their products. Mac OS X eliminates the need for ATM Light because its built-in font rasterizer (part of ATS) works for all font formats, including PostScript and OpenType.

This paper will help you learn more about Mac OS X font technology and show you how you can use Panther to express your creative ideas better than ever.
New Font Features in Panther

Panther offers a number of exciting new font technologies and applications. Font Book, the Font panel, and the Character Palette make it easy to access and manipulate fonts in your Mac OS X applications. You can use them to work with your fonts in a consistent manner from program to program.

Font Book

Font Book provides a window into all of your fonts, regardless of whether they’re installed in your private directory, shared with all users of a particular Mac, or shared with everyone on the network. So no matter where a font is placed on your system or who can access it, you can view and manage it from a single, central location.

Font Book lets you easily install and preview fonts; search through them; create font collections; and disable, enable, and remove fonts. For example, you can use Font Book to customize the fonts that are accessible to all Mac OS X applications, giving you quick access to the fonts you need while not cluttering the Font menu with the ones you don’t.

Managing fonts with Font Book is similar to managing songs with iTunes. You can create collections of fonts (similar to iTunes playlists), and then use the collections to access the fonts you need at any given time.

You can use Font Book by itself for your day-to-day font needs, or in conjunction with a third-party font manager. Because Font Book is a separate application rather than part of the operating system, it is an excellent complement to third-party font managers.
Font Panel

The new Font panel in Panther lets you access fonts from a number of Mac OS X applications—including Mail, TextEdit, and Keynote. You can use the Font panel to preview fonts, create font collections for specific clients or jobs, and add fonts to a favorites menu. Any action you take in the Font panel is reflected in Font Book to ensure consistency and save time. The Font panel also lets Mac OS X software developers incorporate a standard font selection interface into their applications.

1. The Font panel provides a preview of a font at a particular size.
2. Installed fonts can be grouped in a collection for easier selection. Changes made to collections in the Font panel are reflected in Font Book.
3. Fonts can be sized by entering a value, clicking a size in the list, or using the adjustable slider.
4. The Action pop-up menu in the Font panel provides access to the Typography panel, the Character Palette, and other features.
The Typography panel allows you to tailor fonts so they are exactly right for the project at hand. Controllable features include ligatures, style variations, kerning, number spacing, fraction rendering, swashes, number and letter case, and more.

You access the Typography panel from the Action menu in the lower-left corner of the Font panel. This panel changes depending on the font you've selected in the Font panel.

The following are two examples of how fonts can be modified using the Typography panel.

Stylistic control
This is the Typography panel for the Hoefler Text font included with Mac OS X Panther. It’s one of several fonts with an extensive array of options that you can set on a character-by-character basis.
Character Palette

The Character Palette makes it easy to locate a specific character or symbol on your system, preview it, and select among its different variations—across all the active fonts on your system. In addition to providing a view of characters by font (similar to the preview capability in Font Book), the Character Palette lets you view individual characters grouped in various categories. You can access the Character Palette in three ways:

• **Special Characters.** You can display this palette by selecting Special Characters from the Edit menu in many Panther applications.

• **International menu.** If you have enabled the Input menu in the International pane of System Preferences, you’ll see the Character Palette under the flag icon in the Mac OS X menu bar.

• **Font panel menu.** You can view the palette by selecting the Characters item from the Action menu in the lower-left corner of the Font panel.

See the “Character variations” sidebar for one use of the Character Palette.

Keyboard Viewer

Fans of the Key Caps utility in Mac OS 9 will want to try the Keyboard Viewer in Mac OS X (System Preferences > International pane > Input Menu). This handy palette lets you view the way the keys on your keyboard map to the characters in each font.

If you need to operate your Mac in a different language but do not have an international keyboard, the Keyboard Viewer makes it easy to enter the characters you need. It changes its character base to match the language you’ve switched to.

The Character Palette provides access to individual glyphs.

1. Choose from several view options.
2. View Roman fonts by category or by favorites.
3. Adding a favorite glyph is a one-click operation.
4. Once you’ve selected a glyph, you can insert it into your document by double-clicking it, dragging it from the well, or clicking the Insert button.
5. Choose the font you want to search or limit your options to just the fonts that contain the glyph you want.
6. See a preview of the glyph and the glyph’s name.
Font Management

Mac OS X Panther lets you organize and access fonts with unprecedented control and ease. Whether you want to store fonts on a central server, activate and deactivate groups of fonts with a click of the mouse, or organize fonts for a third-party font manager, Mac OS X has the tools you need—already built in.

Mac OS X offers broader support for a variety of font formats than any other operating system, so it can handle and manage virtually any type of font you have in your creative arsenal.

Here are a few general guidelines for installing your fonts in Panther, depending on what type of font you’re using.

For PostScript fonts, you will need to install both the screen (FFIL) files and the printer (LWFN) files that correspond to each typeface to make everything display and print correctly on your Mac OS X system. If you copy files from a CD that has both Macintosh and Windows versions of PostScript fonts, be sure to use the Macintosh versions.

Mac OS X also supports Multiple Master fonts, a special type of PostScript font. As with other PostScript fonts, you will need to install both screen and printer files.

TrueType fonts have all the information they need for both onscreen display and printing in a single file, so you need to install only one file for each TrueType font. Note that Mac OS X can use both Windows and Macintosh TrueType fonts, but you need to copy only the main TrueType font file. You don’t need to install the Windows AFM file.

OpenType fonts and Mac OS X offer the benefit of letting you use an unlimited number of characters. In addition to eliminating character limits, with Mac OS X you no longer have to worry about using Expert typefaces as you did in previous Macintosh operating systems. When installing an OpenType font, you need to copy only one file for each typeface, because the file contains everything needed for both screen display and printing.
Mac OS X Font Locations

Mac OS X is a versatile, multiuser operating system—a major benefit in creative environments. To maximize creative options and workflow productivity, you can set up one system exactly how you like it, and configure the same system to suit the preferences of other users such as freelance designers.

This versatility also goes for fonts, which can be stored so they’re available to a specified user, to all users of a certain Mac, or to everyone on a network. You can control which fonts are used for a specific job or client, and which users have access to each font. Hierarchical font folders allow you to create multiple levels of font folders within font directories for even better organization.

No matter where you’ve installed fonts, Panther immediately recognizes and activates fonts installed in any of the font folder locations, including subfolders. (See Appendix D for details on active font locations.) If you activate or deactivate fonts frequently, it’s best to use the built-in Font Book application or one of the third-party font management applications available for Mac OS X. Keep in mind that while you can use individual folders to install fonts, Font Book is your preferred option because it lets you easily install fonts and make them accessible from a central location instead of having to copy them to individual folders.

Home directories

If you are the only person who uses your Mac, then making your fonts accessible to your home directory is your top priority. This is the directory you go to when you click the house icon in a Mac OS X Finder window. If you would like to install fonts that only you are going to use, drag them into the ~/<user name>/Library/Fonts folder. This location will make the fonts accessible when you are working in your home directory. See Appendix D (“Font Locations in Mac OS X”) for more information on where to install fonts.

Fonts installed by applications

Some applications come with fonts and automatically install them in the Library/Application Support folders. Unless you move them, these fonts will be accessible only to those individual programs. Making these fonts accessible across all of your applications is simple. Just move them to systemwide or user font folders such as /Library/Fonts or /Users/<your user name>/Library/Fonts (also referred to as ~/Library/Fonts).

Note that Adobe Creative Suite uses some fonts to generate dialogs and help menus. It installs these fonts in a folder called Reqd in the Application Support folder. Do not move the fonts to a different folder.

Other applications may install special fonts in one of the Mac OS X font folders instead of in their own folders. To simplify font management, you might want to use Font Book to make a collection of each application’s fonts. This strategy will allow you to deactivate the fonts and create “clean” font lists in the system font folders.

Some applications, such as Microsoft Word, update their font menus only at application launch. You’ll need to quit and restart these applications after activating or deactivating fonts. It isn’t necessary to quit and restart applications such as Adobe InDesign CS that automatically recognize font changes.

To find out if you need to restart an application, check its Font menu immediately after you add a new font. If the font doesn’t show up, simply quit and relaunch the application.
Classic Fonts and Applications

If you work with Classic applications, you’ll find that Mac OS X offers a number of features that improve on the font management capabilities that were available to you in Mac OS 9. Because you are essentially running two different operating systems side by side—Mac OS 9 and Mac OS X—there are a few font issues you should know about.

Font smoothing

With built-in anti-aliasing technology for font smoothing onscreen, Mac OS X eliminates the need to use extra applications such as ATM Light. However, if you use Classic applications with PostScript fonts, you’ll need to install ATM Light version 4.6.2 or later. This application is a free download from Adobe at www.adobe.com/support/downloads. If you run Adobe Photoshop in Classic, you don’t need ATM Light, because Photoshop 5.5 and later versions handle their own font rendering.

Font folder hierarchies

Mac OS X uses font folder hierarchies to determine which fonts to use. For example, if you have a PostScript version of Helvetica installed in the Classic Fonts folder (<startup volume>/System Folder/Fonts), it will work fine for Classic applications. But for Mac OS X applications, the system will use the Helvetica font located in /System/Library/Fonts—a higher-priority folder for Mac OS X. As a result, you could wind up using two different versions of Helvetica if you are running both QuarkXPress in Classic and Adobe Illustrator in Mac OS X, for example.

To avoid this problem, be sure there are no font name duplicates between fonts in your Classic Fonts folder and fonts in higher-priority folders such as /System/Library/Fonts. (See Appendix D for information about folder priorities.)

Font suitcases

Panther lets you use all your favorite legacy fonts, including those that started as a font suitcase in Mac OS 9. If you’ve brought a font suitcase into Mac OS X, the file might contain both TrueType and PostScript versions of the same font. Mac OS X will open and use both fonts, creating potential conflicts.

The best way to prevent this problem is to extract all screen fonts from the suitcase and then install the specific fonts you need using Font Book or your third-party font manager. You can open the suitcase in a Finder window on a Mac that has been started up in Mac OS 9 or earlier and extract the fonts, or you can find and install a copy of Font/DA Mover 4.1 and run it in the Classic environment of Mac OS X to disassemble the suitcase.

See Appendix A for information about products that can help resolve suitcase issues.

Server-Based Fonts

By creating a central font location on a local or network computer, you can make fonts available to multiple Mac users quickly and easily. What’s more, you’ll be certain that everyone involved with a specific project—from initial design to final printout—is using the same version of each font, no matter which Mac they’re working on. Having a central font location can also reduce system administration efforts.

To store fonts centrally, mount the server volume on the local computer and point your font manager at the fonts in that location to open them. Make sure that your network can handle the extra font-sharing traffic. A 100BASE-T switched network or better is recommended for font servers and clients.
Sharing fonts on the network

If you have a system running Mac OS X Server version 10.3, you can—with the proper licenses—set up fonts to be shared easily across multiple computers.

Follow these steps:

1. Install the fonts in a folder called Library/Fonts on the system running Mac OS X Server.
2. Open Workgroup Manager and click Sharing.
3. Click Share Points and select the folder that contains the fonts.
4. Click Network Mount.
5. From the Where pop-up menu, choose the directory domain that contains your users and computers. If the correct directory is already selected, click the lock to authenticate.
6. Choose the sharing protocol (AFP or NFS) from the Protocol pop-up menu.
7. For the “Use for” setting, select Shared Library to share your Fonts folder under /Network/Library.
8. Click Save.

For more information, see the Mac OS X Server File Services Administration Guide.

You can also use third-party software to automatically activate and manage version numbers and client-specific fonts. These products usually have a server-based software application; you can then add clients as necessary.

Managing Fonts with Font Book

Panther lets you continue to use all of your legacy fonts, as well as new OpenType and other fonts, and manage all of them from a central location—the Font Book application. While you can install fonts in individual folders, Font Book offers easier installation and management from a central location.

No matter where you store your fonts, Font Book can see them to install them. Font Book can install fonts in locations from which both Classic and Mac OS X applications can access them. You can also use Font Book to create font sets—called “collections”—for specific tasks or software applications, simplifying font management. For Mac OS X, Font Book can activate and deactivate fonts or collections as needed. In design and publishing environments, where users frequently need to switch between sets of fonts, Font Book makes it easy to prepare a base font system and then manage specific fonts for each job.

If you're a designer who deals with dozens of fonts, creating collections is the ideal way to organize your font libraries. Here are some ways you can use collections to manage large libraries.

- **Alphabetically.** Organize fonts in alphabetical groups, such as A–D, E–H, and so on. This is the simplest method of organization, and it allows for fast navigation when searching for a font name.

- **By project name.** Create a collection of fonts that you plan to use for a particular project, so you see only the fonts you need.

- **By client.** Many clients require a specific set of fonts for all of their projects. Creating a collection makes it easier to reenable the fonts you need when working on these projects.
Font Book lets you create any number of collections, making it easier than ever to organize your fonts and activate specific sets when you need them. Individual font families can be placed in multiple collections.

If you manage fonts from many different sources that contain duplicate fonts of the same name, you will need to use Font Book in a very specific manner. See the discussion of prepress and production font management on page 25 for more information. Also see Appendix A for information about third-party font utilities.

### Setting Font Book preferences

Font Book displays all the fonts currently installed on your Mac and makes it easy to install additional fonts. When you use Font Book to install a font, it offers a number of options. Here's how to set your preferences.

Begin by choosing Preferences from the Font Book menu.

The first set of buttons lets you choose who will be able to access the installed fonts. Font Book then installs the fonts in the proper folder for your chosen access privileges. The choices are “for me only” (the default), “for all users of this computer,” and “for Classic Mac OS.” Of course, the last option is not displayed if you do not have the Classic environment installed on your system.

You can override the preferred installation location by dragging the font or the folder containing the font directly to the desired location under “All Fonts.”

The second set of buttons controls what happens when you disable a Font Book collection. The choices are “just the collection” (the default) and “all fonts in the collection.” The recommended practice in a design environment, where you want the fonts in a set to be deactivated when the set is deactivated, is to choose “all fonts in the collection.”

At the bottom of the Preferences window is a checkbox labeled “Always copy font files when installing.” It’s best to check this box to ensure that font files are copied when installing. If this preference is off (the default setting), fonts that Font Book has installed on the current hard drive will be moved into the location specified in the Font Book preferences. If the font is on a separate volume, it will be copied to the designated Font Book installation location.

You can now close the Preferences window.

### Installing fonts with Font Book

Once you've set your Font Book preferences, you're ready to begin installing fonts.

You can add fonts to Font Book in two ways: by selecting the fonts in the Finder or by dragging them into Font Book. With both options, fonts are automatically activated once they're installed. You can later disable specific fonts, allowing you to control which fonts are active for a job without having to physically remove the ones you don't need.
When installing fonts in Font Book, the best method is to start with your original font sources—typically CDs or DVDs—and add the fonts to Font Book using the All Fonts menu. If you have graphics applications that you still use in Classic, it’s best to add all of your fonts to the Classic location. If you have only Mac OS X applications, then either choose Computer to make the fonts available to all users of that computer, or choose User to make the fonts available only to the current user. Unless your original sources contain a lot of duplicates, starting from the original source of the fonts will reduce duplicate fonts and the risk of installing damaged fonts.

Selecting fonts in the Finder
To add a font to Font Book from the Finder, begin by viewing your available fonts in a Finder window. Double-click the font you want to add. Font Book displays a preview of the font. If the font you want to add is a PostScript font, be sure to double-click the screen font, not the printer font. A pop-up menu above the font sample indicates the available styles for that font.

Because PostScript fonts have both screen files (1) and printer files (2), you must click the screen font's suitcase to activate Font Book and add these fonts to your collection.

To install the selected font, click Install Font.
Dragging and dropping
Adding fonts from the Finder is an easy way to install a new collection. You can drag a folder containing fonts into the Collection list in Font Book.

When you drag one folder to the list, the new collection maintains the name of the top-level directory. Fonts installed in this manner are always installed in the User fonts folder. For example, if you drag a folder for WarnockPro into the Collection list, you will see a new font set in Font Book called WarnockPro.

If you drag two or more folders, Font Book combines the directories into one set and assigns a new name. Note that creating collections by dragging folders from the Finder rather than selecting fonts from the font list may result in duplicate fonts being added to Font Book. (See the “Duplicate fonts” section on page 19 for tips on how to handle this situation.)

Using this method only installs the font; it does not create a collection. You can then create a collection and add the font to it.

Previewing fonts
Once a font is installed, you can preview it in different ways from the Preview menu in Font Book:

• **Sample.** Shows the font using a standard alphabetical list of characters.
• **Repertoire.** Shows the entire list of characters available in the font.
• **Custom.** Shows what a custom string of text looks like in the font. This option allows you to type in the preview window.
• **Classic.** If you have the Classic environment installed on your Mac OS X system, this option is displayed.

In all font preview modes, you can zoom in and out to view a font in a wide range of sizes.
Searching for fonts
In addition to previewing fonts, Panther makes it easy to quickly find the fonts you need, even if you use dozens of fonts. You can search for fonts by their family name, such as Helvetica or Times, or by the typeface name, such as Bold, Condensed, or Italic. The latter can be very useful for finding the right style of font even if you don’t know the name. In the example below, a search for Bold shows only those families and typefaces with fonts that are bold.

Building and managing Font Book collections
Once you have all of your fonts installed, you’re ready to get organized and save time by making font collections. Mac OS X provides several collections to get you started.

All Fonts collection
The default collection of fonts on your system is All Fonts. This collection shows all the fonts that Font Book can control on your computer, whether they’re installed in your private directory, shared with all users of your Mac, or shared with everyone on the network. This collection is special because it displays fonts no matter where they are stored on your system or who can access them.

• **User.** These fonts are installed in a user’s /Library/Fonts folder. They are available only to that user.

• **Computer.** These fonts are installed in either /System/Library/Fonts or /Library/Fonts. They are shared with all users of the Mac.

• **Network.** If you are on a network with a server that shares fonts, then these fonts appear in the All Fonts collection.

Note that Font Book is designed to manage fonts that are in approved Mac OS X system locations. It does not affect application-specific fonts.
Creating System and Master Font Book collections

As a design or print professional, you probably need to add, delete, activate, and deactivate fonts frequently for different clients or projects. Sometimes you might also want to deactivate some of your installed fonts and use other font formats from previous projects or for print specifications.

When you turn fonts on and off, you need to ensure that you do not deactivate fonts that Mac OS X requires for proper operation and user interface display. To do this, use Font Book to copy the All Fonts collection and divide the copy into two new sets: one that will be protected from deactivation—System fonts; and another for all your other fonts—Master fonts.

Creating a System font set

Your System font collection contains all the fonts that Mac OS X needs for dialogs, basic text input, and international language support. For this reason, you need to create a protected collection of these fonts to ensure that they can never be disabled.

To create a System set:

1. Click the Add button (+) below the Collection column.
2. Type System for the name of the set, then press Return.
3. Select All Fonts in the Collection list.
4. Drag the following fonts from All Fonts to System:
   - Lucida Grande
   - Monaco

When you add fonts to your library, you have two options. You can add them to the All Fonts collection, then to your Master Fonts set, and then to the specific collection you wish to have open. Alternatively, if you prefer to place your favorite fonts in your user fonts folder (~/.Library/Fonts), there is no need to add the font to the All Fonts collection. Mac OS X automatically places fonts in All Fonts if you’ve added them to your user fonts folder.

Keyboard and LastResort fonts

If you view your fonts in a Finder window rather than in Font Book, you may see the fonts Keyboard and LastResort. They are located in the System folder and are vital if there is ever a problem with your managed fonts. They will not affect your print jobs or show up in your applications. Never delete Keyboard or LastResort.
Creating a Master Fonts set

Now that you've created a System Font Book collection to protect certain fonts from deactivation, you can gather all of your favorite fonts into “Master Fonts,” your base font collection. The Master Fonts collection gives you easy access to your fonts. It can also play an important role when you need to add fonts for a certain job or check that all the fonts you need for the job are available. If you create a new collection containing job-specific fonts, disable your Master Fonts, and then view the document for the current project, Mac OS X alerts you to any missing fonts. You can then go back and add the necessary fonts to the job-specific collection.

Here's how to create a Master Fonts set in Font Book:

1. Click the Add button (+) below the Collection column.
2. Type Master Fonts and press Return.
3. Select All Fonts in the Collection list and press Command-A to select all the fonts.
4. Drag the fonts to Master Fonts. You have now duplicated your All Fonts collection.
5. Remove the following fonts from the Master Fonts list by selecting them and choosing Remove Font from the File menu:
   • Lucida Grande
   • Monaco
   • Charcoal (if you will be using Classic applications)

(If you see two versions of any of these fonts, remove both copies.)

Remember that this action removes only the fonts from the current collection, not from Font Book or your system.

Following these instructions will ensure the proper functioning of Mac OS X as well as Apple applications such as Mail, Safari, iCal, and Address Book. However, some third-party applications might require other system fonts to display documents or draw dialogs. Always be cautious when deactivating system fonts, and be prepared to reactivate them if you encounter any application problems.

You can build additional collections over time as needed for particular jobs. After a job is completed, you can delete the job’s collection, or save it if you think you’ll need it again in the future.

Enabling and disabling fonts

Panther automatically activates fonts as soon as they are added to Font Book. From Font Book, enabling and disabling fonts as you need them is an easy process.

To disable a font or an entire collection, select it in Font Book and click the Disable button at the bottom of the window. To reactivate a font or a collection, select the desired item and click the Enable button at the bottom of the window. Font Book toggles the button's label between Disable and Enable as appropriate. Disabled fonts are marked “Off” next to their names.

Note that there are two possible behaviors for the Disable button for a collection. If you have selected “just the collection” in Font Book preferences, then the set is disabled in the Mac OS X Font panel, but the fonts in the set are still active in all other application menus. However, if you have selected “all fonts in the collection,” disabling turns off the set and all the fonts in it.
Font Book and Classic applications
Font Book is designed to manage fonts for Mac OS X applications, so activating and deactivating fonts in Font Book does not affect the fonts you use in Classic applications. Any font in the Fonts folder of your Classic System Folder will always show up in the font lists of your Classic applications, even if you have disabled it in Font Book.

If you want to use a single application to manage fonts for both Classic and Mac OS X applications, you will want to consider a third-party font manager.

Duplicate fonts
Font Book displays fonts stored in all the hierarchical font folders in Mac OS X. When there are two or more copies of a font with the same name, Font Book marks the duplicates with a dot. The one without the dot is the active font.

If you do not use Font Book to resolve or remove duplicates, the locations of the different copies in the Mac OS X system hierarchy determine which font gets used. See Appendix D for more information on the font usage hierarchy in Mac OS X.

Font Book offers both automatic and manual methods of activating a specific font from among duplicate fonts.

For convenience, Font Book can fix duplication problems automatically. Simply select the fonts, then choose Resolve Duplicates from the Edit menu. Be sure that you have not selected a specific font from the list before choosing Resolve Duplicates. Font Book makes the last font loaded in ~/Library/Fonts the active font and deactivates all the duplicate copies.

Alternatively, you can resolve duplicate fonts manually. To do this, click the specific font you want to activate, then choose Edit > Resolve Duplicates. The font you selected is activated, and all of the duplicates are deactivated. You can also disable a specific version of a font by using the Disable button.

Each duplicate font is shown in every set. To help you tell the fonts apart when you’re choosing which one to activate, position your cursor over one of them in the list. A yellow “tool tip” appears that displays detailed information about the font, including its location.
If you have both Classic and Mac OS X versions of a font and you choose the Classic font (the one stored in /System Folder/Fonts) as the one to keep, that font will continue to work in both Mac OS X and Classic. If you select a version outside of the Mac OS 9 System Folder (such as /Library/Fonts), that font will no longer be available to Classic applications.

Organizing Fonts for a Third-Party Font Manager

You can organize fonts for a font manager in many ways. However, most creative professionals follow the same basic strategies and organizational structures.

Members of creative workgroups who do not have a fast internal network or access to a central file server might prefer to manage fonts locally on their individual computers. However, if you have a fairly robust network and a central location for application files, it is best to centralize your fonts on a server. See page 11 for more information about server-based fonts.

You can organize fonts on local drives in several ways: by client, by job, and by name. In addition, some third-party font managers offer special locations for font storage, but you might not have to use that location. Check with the company that provides the font manager.

Here are a few best practices used in the industry.

- **Organizing fonts by client.** This option is useful in design shops with many clients, where each client has a specific identity package.
- **Organizing fonts by job.** This option is especially useful in service bureaus.
- **Organizing fonts by name.** This is a good option for design shops that regularly use an assortment of fonts.
Optimizing a Production System

Depending on your workflow requirements, you might find it helpful to optimize font organization on your Macintosh workstations. This section describes how to deal with nonessential fonts either temporarily or permanently and addresses some of the special font management needs of service bureaus.

Removing or Deactivating Nonessential Fonts

In Mac OS X, as in Mac OS 9, fonts located in system-recognized font folders are always on and available to applications, unless you have used a font manager to override or deactivate them. To prepare your system for the strict font requirements of design and production, you might want to remove or deactivate some of the preinstalled fonts in Mac OS X that will conflict with versions or formats of the fonts you use in your workflow. You might also wish to remove or deactivate fonts that you do not plan to use so that they will not show up in your font lists.

Using Font Book, you can deactivate fonts and leave them in place rather than removing them entirely. If you plan to use a third-party tool to manage your fonts, it’s advisable to remove nonessential fonts from the system locations so that those fonts are not accidentally activated. Note that some of the preinstalled Mac OS X fonts have additional characters you might want to use, such as foreign language characters. You can use the Character Palette to browse the glyphs of a font before deciding whether to remove it (choose Glyph from the View pop-up menu).

When choosing which fonts you want keep and which you want to remove, be careful not to delete fonts that are required by Mac OS X and/or the Classic environment. Removing required fonts may prevent your Mac from starting up or cause application problems. Required fonts are listed in the sections that follow.

You can remove nonessential fonts manually in the Finder by dragging them to the Trash. If you attempt to remove a font from the System folder /Library/Fonts, you will be asked to authenticate your ID with an administrator’s login and password.

To remove fonts using Font Book, follow these steps.

Removing or deactivating fonts in Classic

The fonts in the System Folder in Classic support applications that run in the Classic Mac OS 9 environment. However, all applications, including Mac OS X applications, can access these fonts. You may therefore have duplicate fonts—those that Classic uses and those that Mac OS X uses. Follow the steps below to remove fonts with names that conflict with fonts you’re going to be using in production.
1 Open Font Book.
2 Click the triangle next to All Fonts.
3 Select Classic Mac OS. This option shows the Fonts folder in your Classic System Folder.
4 Select the fonts you wish to remove. To select multiple fonts that are contiguous in the list, use Shift-click. To select noncontiguous fonts, use Command-click.
5 Now choose either Remove Font from the File menu or Disable Font from the Edit menu.

The following Classic fonts are commonly removed or disabled:
- Courier
- Helvetica
- New York
- Symbol
- Times
- Zapf Dingbats

Do not remove these fonts:
- Charcoal
- Chicago
- Geneva
- Monaco

Removing or disabling these fonts may cause some of your Classic applications to work improperly.

Deleted fonts are now in the Trash. If you prefer, you can remove the fonts from the Trash and place them in a folder in case you wish to add them back at a later time. Store the fonts in a safe place, such as a new folder named “Fonts Removed from Classic” in your home folder or in the /Users/Shared folder.
Removing or deactivating fonts in Mac OS X

Font Book makes it easy to remove fonts from the Mac OS X system, regardless of where the fonts reside.

1. Open Font Book.
2. Click the triangle next to All Fonts.
3. Select Computer. This option shows the fonts from two physical locations on your hard drive: /System/Library/Fonts (requires administrator access) and <startup volume>/Library/Fonts. This is the place for fonts that you want to make available to all users of the computer.
4. Select the fonts you wish to remove. To select multiple fonts that are contiguous in the list, use Shift-click. To select noncontiguous fonts, use Command-click.
5. Now choose either Remove Font from the File menu or Disable Font from the Edit menu.

The following fonts are commonly removed:
- Courier
- Futura
- GillSans
- Helvetica
- Helvetica Neue
- Times New Roman

These fonts are usually replaced with your preferred version by using Font Book or a third-party font manager. You can also remove the various foreign language fonts if the system is going to be used only with Roman languages. If you are using a localized system, you may also need some specific system fonts for that language.

**Lucida Grande is an essential system font.** Never remove it. Doing so will prevent the system from starting up and will likely require reinstallation of the operating system. You should also leave these fonts:
- Geneva.dfont
- Keyboard.dfont
- LastResort.dfont
- Monaco.dfont

Otherwise, some of your applications might not display text correctly.

If you selected any fonts for removal that were in the /System/Library/Fonts folder, you are asked to authenticate your ID as an administrator before the fonts are moved to the Trash. You are not asked to authenticate your ID if you are simply disabling the font.

The deleted fonts are now in the Trash. If you prefer, you can remove the fonts from the Trash and place them in a folder in case you wish to add them back at a later time. Store the fonts in a safe place, such as a new folder named “Fonts Removed from Mac OS X” in your home folder or in the /Users/Shared folder.
Keeping a version of Helvetica

A few Mac OS X applications require an active version of Helvetica. The most common symptom when Helvetica is missing is that the application does not display windows or type does not display correctly. Corrupt fonts can also cause incorrect type display. (See Appendix A, “Additional Resources,” for more information on this topic.)

If you regularly use any applications that require Helvetica: As soon as you remove Helvetica from the system, be sure to install another version of Helvetica with your font manager of choice. It doesn’t matter which font format you use—TrueType, OpenType, or PostScript—as long as one version of Helvetica is present.

Removing or deactivating fonts on international systems

In addition to the fonts discussed previously that are required for any Mac OS X system (Lucida Grande, Monaco, Keyboard, and LastResort), each international version of Mac OS X requires specific fonts for proper operation.

You can determine which fonts are system fonts by looking in /System/Library/Fonts. The fonts that must not be removed are listed below. They are also marked with a lock icon when you view them with Font Book. Apple recommends that you leave all of these fonts in place even if you do not plan to use all of the listed languages, because you never know who might use your system or how it might be used in the future.

Required Japanese fonts:
- Hiragino Kaku Gothic Pro W3 and W6
- Hiragino Mincho Pro
- AquaKana
- Osaka and Osaka Mono (needed for application compatibility)

Required Traditional Chinese fonts:
- LiHei Pro
- Apple LiGothic Medium (needed for application compatibility)
- Hei (needed for application compatibility)

Required Simplified Chinese fonts:
- STXiHei
- STHeiti

Required Korean font:
- AppleGothic Regular

Required Arabic font:
- Geeza Pro Regular and Bold
Font Management for Prepress and Production

Font Book does not create a direct link from a specific font to the collection it came from; therefore, service bureaus and other users who need to manage many duplicates and keep them linked to a set or a collection might want to use Font Book in a special manner.

If you frequently receive groups of fonts for specific jobs, it's best to add the set, do the job, then delete the collection and the fonts associated with it before adding another set. This procedure will keep your System folder free of duplicate fonts.

- For single users who run only Mac OS X applications: Store fonts in the user's personal Fonts folder (~/.Library/Fonts).
- For multiple users of a single computer who run Mac OS X applications exclusively: A user with administrator rights should store fonts in the Library at <startup volume>/Library/Fonts. This approach provides a common set of fonts for all users.
- For users who run both Classic and Mac OS X applications: Place fonts in the Fonts folder in the Mac OS 9 System Folder.

Replacing common publishing fonts

In Mac OS X, five fonts are installed in /System/Library/Fonts that you might want to replace with your PostScript version of the fonts. Service bureaus might want to replace fonts with a customer's version on a per-job basis using a font manager. These fonts are Courier.dfont, Helvetica.dfont, Symbol.dfont, Times.dfont, and Zapf Dingbats.dfont.

Working with Mac OS X plist files for fonts

Mac OS X simplifies font management because you don't need to move a font out of a folder to deactivate it. Font Book lets you store fonts in a number of different directories in Mac OS X and disable them while still leaving them in place. Note that the "disabling in place" approach is not recommended in prepress environments because fonts that are in the system-level font folders are automatically active unless they are explicitly deactivated through Font Book. Use Font Book to see whether fonts are active—viewing fonts in the Finder will not show you whether a font is enabled or disabled.

Mac OS X disables individual fonts by creating a preferences file called com.apple.ATS.plist for each user. This file tells the operating system which fonts are disabled. You can use a font manager to override fonts installed in the system-level font folders; however, you will not get a missing-font warning from an application if a system font is active. In addition, if the Font Book preferences file is accidentally deleted or rebuilt, any fonts in the system-level font folders revert to their active state. You might not notice this reactivation, creating a risk of accidental font substitution by the once-again-active font. If you notice any anomalies, simply use Font Book or your third-party font manager to ensure that the correct fonts are enabled.
Managing multiple versions of a font

If you have documents that use PostScript versions of a font with the same name, such as Helvetica, rather than the dfont version that comes with Mac OS X, you will want to make sure that you use the same font for output that was used during the original design of the document. Otherwise, the type might flow differently or glyphs might be substituted. To ensure that the correct version of the font is used, you can perform any of the following actions:

• Activate the replacement font in Font Book.
• Remove the font and replace it with your version.
• Remove the font and use a third-party font manager to open the new version of the font.
• Convert the output file to a PDF and embed all fonts.

It's easy to verify which font is actually in use, determine the fonts necessary for printing a file, and ensure that a customer's font versions are being used. Simply create a Master Fonts set as outlined previously, then use Font Book to create a new collection containing job-specific fonts. If you disable your Master Fonts and then view the document for the current project, Mac OS X will alert you to any missing fonts. You can add the necessary fonts to the job-specific collection.

Deleting font caches

If your fonts are garbled, or if there are fonts that won't empty from the Trash even after you restart your Mac, try deleting the Mac OS X font caches.

You can do this manually by finding and removing these files:

• In /System/Library/Caches:
  – fontTablesAnnex
    (fontTablesAnnex contains the character encodings/mappings for all of the fonts on your system. Information in this file can lead to garbled text.)
  – com.apple.ATS.System.fcache
  – com.apple.ATSServer.FODB_System
• In /Library/Caches:
  – com.apple.ATS
• In your home directory’s Library/Preferences folder:
  – com.apple.ATS.plist

Font corruption

In Mac OS 9, if two fonts had the same internal ID number, Mac OS 9 renumbered one of them to avoid conflicts. As a result, sometimes a font file became corrupted, triggering application and system crashes.

Mac OS X doesn't try to alter fonts, so the chances of a font file becoming corrupted are almost nonexistent. This doesn't mean that there are no longer corrupt fonts. Legacy fonts from earlier systems and fonts purchased from nonstandard vendors may still cause issues.
Appendix A: Additional Resources

Many commercial, shareware, and freeware font utilities are available. They fall into the following general categories:

• Waterfall-style viewers display “quick brown fox” or other font samples, sometimes for multiple fonts simultaneously.

• Spec sheet utilities print a list of fonts along with sample output from each selected font.

• Analysis and repair utilities locate, report, and sometimes repair damaged font files; some utilities can reorganize your fonts alphabetically or by other characteristics.

• Management (activation) utilities let you activate and deactivate fonts on demand.

• Utilities that delete font caches are helpful for troubleshooting font problems.

This appendix offers information about a number of products that provide additional functionality in working with fonts or that can solve some of the most frequent problems you might encounter with fonts.

Two good resources for font utilities are the Macintosh Products Guide (www.apple.com/guide) and Version Tracker (www.versiontracker.com).

**How third-party font managers extend the capabilities of Font Book**

Third-party font management products can augment and extend the capabilities of Font Book. Most popular font management products allow you to:

• Automatically activate fonts in Adobe Creative Suite, QuarkXPress, and other popular design applications.

• Keep a font set or a collection name linked to the specific font that was added to that set.

• Activate and deactivate fonts for Classic applications from the Mac OS X user interface.

• Select multiple collections at the same time and activate or deactivate them.

• Manage your fonts from a server.

• Automatically sort and categorize fonts.

• Print books of font samples.
The following are a few examples:

**FontAgent Pro.** Insider Software’s FontAgent Pro helps you maintain font integrity, create custom font sets, and activate them when they are needed.

**Font Cache Cleaner and Font Cache Expunger.** You can use one of several utilities to automate the process of deleting font caches, including Font Cache Cleaner (www.versiontracker.com) and Font Cache Expunger (www.elara.com).

If you are using Font Book, all of your fonts will be activated after you delete the system font caches.

**FontDoctor.** FontDoctor from Morrison SoftDesign provides font problem diagnosis and repair. It includes a wide range of repair methods for damaged font tables, font ID conflicts, duplicate fonts, extra font sizes, and mixed font types.

**Font Lab.** Glyphs—usually individual letters or shapes—may sometimes appear cut off, both on screen and in your printed output. You can use Font Lab (www.fontlab.com) to repair and resave these fonts.

**Font Reserve.** Font Reserve from Extensis gives you the ability to organize, maintain, use, and manage your fonts. It’s available in both single-user and server versions.

**Suitcase X1.** Suitcase X1 from Extensis lets you manage your fonts from a single window, while it works in the background to automatically activate fonts.
Appendix B:
Mac OS X Fonts

American Typewriter: The quick brown fox jumped over the lazy dog.
American Typewriter Light: The quick brown fox jumped over the lazy dog.
American Typewriter Bold: The quick brown fox jumped over the lazy dog.
American Typewriter Condensed: The quick brown fox jumped over the lazy dog.
American Typewriter Condensed Bold: The quick brown fox jumped over the lazy dog.
Arial: The quick brown fox jumped over the lazy dog.
Arial Italic: The quick brown fox jumped over the lazy dog.
Arial Bold: The quick brown fox jumped over the lazy dog.
Arial Bold Italic: The quick brown fox jumped over the lazy dog.
Arial Black: The quick brown fox jumped over the lazy dog.
Arial Narrow: The quick brown fox jumped over the lazy dog.
Arial Narrow Italic: The quick brown fox jumped over the lazy dog.
Arial Narrow Bold: The quick brown fox jumped over the lazy dog.
Arial Narrow Bold Italic: The quick brown fox jumped over the lazy dog.
Arial Rounded MT Bold: The quick brown fox jumped over the lazy dog.
Baskerville: The quick brown fox jumped over the lazy dog.
Baskerville Italic: The quick brown fox jumped over the lazy dog.
Baskerville Bold: The quick brown fox jumped over the lazy dog.
Baskerville SemiBold: The quick brown fox jumped over the lazy dog.
Baskerville SemiBold Italic: The quick brown fox jumped over the lazy dog.
Baskerville Bold Italic: The quick brown fox jumped over the lazy dog.
Big Caslon Medium: The quick brown fox jumped over the lazy dog.
Brass Serif MT Italic: The quick brown fox jumped over the lazy dog.
Comic Sans MS: The quick brown fox jumped over the lazy dog.
Comic Sans MS Bold: The quick brown fox jumped over the lazy dog.
Copperplate: The quick brown fox jumped over the lazy dog.
Copperplate Light: The quick brown fox jumped over the lazy dog.
Copperplate Bold: The quick brown fox jumped over the lazy dog.
Courier New: The quick brown fox jumped over the lazy dog.
Courier New Italic: The quick brown fox jumped over the lazy dog.
Courier New Bold: The quick brown fox jumped over the lazy dog.
Courier New Bold Italic: The quick brown fox jumped over the lazy dog.
Didot: The quick brown fox jumped over the lazy dog.
Didot Italic: The quick brown fox jumped over the lazy dog.
Didot Bold: The quick brown fox jumped over the lazy dog.
Futura Medium: The quick brown fox jumped over the lazy dog.
Futura Medium Italic: The quick brown fox jumped over the lazy dog.
Futura Condensed Medium: The quick brown fox jumped over the lazy dog.
Futura Condensed ExtraBold: The quick brown fox jumped over the lazy dog.
Geneva: The quick brown fox jumped over the lazy dog.
Georgia: The quick brown fox jumped over the lazy dog.
Georgia Italic: The quick brown fox jumped over the lazy dog.
Georgia Bold: The quick brown fox jumped over the lazy dog.
Georgia Bold Italic: The quick brown fox jumped over the lazy dog.
Gill Sans: The quick brown fox jumped over the lazy dog.
Gill Sans Italic: The quick brown fox jumped over the lazy dog.
Gill Sans Light: The quick brown fox jumped over the lazy dog.
Gill Sans Light Italic: The quick brown fox jumped over the lazy dog.

Gill Sans Bold: The quick brown fox jumped over the lazy dog.
Gill Sans Bold Italic: The quick brown fox jumped over the lazy dog.
Herculanum: The quick brown fox jumped over the lazy dog.
Lucida Grande: The quick brown fox jumped over the lazy dog.
Lucida Grande Bold: The quick brown fox jumped over the lazy dog.
Marker Felt Thin: The quick brown fox jumped over the lazy dog.
Marker Felt Wide: The quick brown fox jumped over the lazy dog.
Optima Regular: The quick brown fox jumped over the lazy dog.
Optima Italic: The quick brown fox jumped over the lazy dog.
Optima Bold: The quick brown fox jumped over the lazy dog.
Optima Bold Italic: The quick brown fox jumped over the lazy dog.
Optima ExtraBlack: The quick brown fox jumped over the lazy dog.
Papyrus: The quick brown fox jumped over the lazy dog.

Trebuchet MS: The quick brown fox jumped over the lazy dog.
Trebuchet MS Italic: The quick brown fox jumped over the lazy dog.

Trebuchet MS Bold: The quick brown fox jumped over the lazy dog.
Trebuchet MS Bold Italic: The quick brown fox jumped over the lazy dog.

Verdana: The quick brown fox jumped over the lazy dog.
Verdana Italic: The quick brown fox jumped over the lazy dog.
Verdana Bold: The quick brown fox jumped over the lazy dog.
Verdana Bold Italic: The quick brown fox jumped over the lazy dog.

Zapfino: The quick brown fox jumped over the lazy dog.
Appendix C: Font Support in Mac OS X

Mac OS X supports tens of thousands of fonts in many different formats. These formats are listed below.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac PostScript Type 1</td>
<td>Adobe PostScript fonts launched desktop publishing and are used today by publishers, corporations, and government agencies for high-quality output to laser printers, imagesetters, and platesetters. Each PostScript font requires two files. One, called the screen font, contains the display information; the other, called the printer font, contains the PostScript outline, which can be rendered to the screen and to an output device.</td>
</tr>
<tr>
<td>Multiple Master</td>
<td>This special PostScript font allows variation of one or more font parameters (such as weight) to create a large number of custom styles, also known as instances. Mac OS X v10.3 can activate already-created instances of this font.</td>
</tr>
<tr>
<td>Mac TrueType</td>
<td>Most current RIPs support Mac TrueType fonts, which are typically used in home and office environments. A single file contains both screen and printer font information. Be sure to embed these fonts when making PDFs or PostScript files to avoid problems at the RIP.</td>
</tr>
<tr>
<td>System (dfonts)</td>
<td>Introduced in Mac OS X, dfonts are specially packaged TrueType fonts that contain information in the data fork instead of in a separate resource fork. Many dfonts are high-quality fonts with extensive glyph sets that designers will love. (Note that applications must support Unicode and be revised to take advantage of these glyph sets.) Some of these names conflict with existing PostScript or TrueType fonts, so you might want to remove them when you prepare your system (see page 21).</td>
</tr>
<tr>
<td>OpenType</td>
<td>OpenType fonts (extension .otf) can contain 65,000 different glyphs, so type can be set in non-Roman languages such as Japanese, Chinese, and Korean. Some applications, such as TextEdit, Adobe InDesign, and Photoshop, support advanced OpenType layout Unicode; other applications get only the basic MacRoman character set from OpenType fonts, and would have to be revised to take advantage of Unicode and advanced OpenType typography.</td>
</tr>
<tr>
<td>Windows TrueType</td>
<td>Same as Mac TrueType, but with a different internal format. The extension is .ttf.</td>
</tr>
</tbody>
</table>
Appendix D: Font Locations in Mac OS X

Mac OS X provides multiple locations for fonts for several reasons:

• Some applications, including Adobe applications such as InDesign, have their own font folders.

• On a computer shared by several users, one user’s fonts might not be the same as another’s, so Mac OS X provides private Fonts folders for individual users.

• Mac OS X is designed to be a multiuser system. It sometimes needs a place for shared resources such as fonts. The /Library/Fonts folder serves this purpose.

• Schools and labs might want to put fonts on a Mac running Mac OS X Server and Open Directory for everyone to share; this is the purpose of the /Network/Library/Fonts folder. (Note that fonts in /Network/Library/Fonts are always open; users can’t open and close these fonts themselves.)

• Multiple font locations with different access privileges protect critical system resources—for instance, essential system fonts needed for menus and dialogs. The /System/Library/Fonts folder lets you see these font suitcases, but you can’t easily open, move, or add to them.

• Finally, supporting Classic applications requires the use of the Fonts folder in the Classic System Folder.

When searching for a font, Mac OS X begins with the application’s font folder and proceeds down the list in the order shown below. It uses the first font match it finds in this sequence. For example, if you have Helvetica in the Classic Fonts folder and Helvetica in your user Fonts folder, the latter takes precedence over the former when you are working in a Mac OS X application.
Here is a list of the places you can install fonts in Mac OS X v10.3. Any fonts that you put into subfolders of these folders are also activated.

<table>
<thead>
<tr>
<th>Font Folder Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application’s own font folder</td>
<td>Some applications create their own font folder either in the application’s folder or in the shared Application Support folder. Note that these applications have their own methods for choosing between conflicting fonts. These methods apply in both Mac OS X and the Classic environment. (For more information on how InDesign handles conflicting font families, see <a href="http://www.adobe.com/support/techdocs/2d1ce.htm">www.adobe.com/support/techdocs/2d1ce.htm</a>.)</td>
</tr>
<tr>
<td>/Users/&lt;your user name&gt;/Library/Fonts</td>
<td>If you’re on a single-user system and you use only Mac OS X applications, this is the place you should put all your fonts. No one but you can use these fonts. If you also run Classic applications, put your fonts in the Classic System Folder Fonts folder instead.</td>
</tr>
<tr>
<td>/Library/Fonts</td>
<td>This collection is the equivalent of the traditional Fonts folder in Mac OS 9. Fonts in this folder are available to everyone who shares a particular Mac. However, only a user with administrator access can change the contents of the folder. In a lab environment, common fonts would be placed here by the Mac system administrator. In a design or production environment without a font manager, shared fonts should be placed here.</td>
</tr>
<tr>
<td>/Network/Library/Fonts</td>
<td>This folder is represented by the Network icon in your Computer folder, but it is located on another computer on the network. It can contain a central font collection to which Mac systems in a network can subscribe. This collection gives everyone a consistent set of fonts. All fonts in this location are always active.</td>
</tr>
<tr>
<td>/System/Library/Fonts</td>
<td>This folder contains all fonts used by Mac OS X for menus, dialogs, and icons. You can see the fonts here, but you can’t modify this folder. Page 23 describes a method for modifying this folder and its fonts.</td>
</tr>
<tr>
<td>&lt;startup volume&gt;/System Folder/Fonts</td>
<td>If you’re running both Classic and Mac OS X applications and you don’t use a font manager, this is the place where you should put all your fonts. This way, Classic applications can use fonts preinstalled in Mac OS X, because this is the only folder from which Classic applications can use fonts. Mac OS X applications can also use fonts in this folder.</td>
</tr>
</tbody>
</table>
Appendix E: International Language Support

Because Mac OS X takes advantage of Unicode—an international computer standard for representing the written languages of all cultures—it is not limited to Roman alphabets. Applications that support Unicode can select characters from a set of up to 65,636 different symbols—almost one glyph for every possible character in every written language. Most fonts don’t need so many symbols, but many non-Roman fonts used in Asia and the Middle East require thousands of different glyphs.

Like ASCII, Unicode is a character encoding system, but Unicode provides a unique number for every character regardless of platform, program, or language. Think of Unicode like assigned seating in a classroom: The person whose last name starts with “A” is always followed by the person whose last name starts with “B,” and they cannot change seats.

The Unicode Standard supports 917,631 characters—enough for all the world’s languages and symbols. The starting point for ASCII, or what was known as Mac encoding, was 256 characters. This was extremely limiting for languages that contain more than a thousand characters, such as Simplified Chinese.

The solution to this limitation has come from the Unicode Consortium, a nonprofit organization that specifies how text is represented in modern software products and standards. Along with Apple, consortium members include HP, IBM, Microsoft, Oracle, SAP, Sun, Sybase, and Unisys. Today the Unicode Standard is supported in many operating systems, all modern browsers, and many other products. It represents one of the most significant advances in global software technology.

As long as an application supports Unicode, this powerful standard allows you to include characters from different languages and different alphabets in a single document or web page and deliver it over multiple platforms, languages, and countries. You do not need to install or reconfigure software to display a wide range of characters and alphabets correctly if you use the default font installation. For example, the extended font set supplied in Mac OS X supports 26 languages, including Central European, Baltic, Greek, Turkish, Cyrillic, and Simplified Chinese. Mac OS X also provides one of the most complete font sets for CJK (Chinese, Japanese, and Korean) fonts—as many as 32,500 characters in the Simplified Chinese font alone.

The Unicode Standard assigns a range of numbers, or “tags,” for a character group. For example, the characters A–Z are assigned the range 65–90. Greek characters are assigned the range 880–1023. In the past, Western font designers wanting to display Greek characters would simply insert the Greek “alpha” in the “a” cell, the Greek “beta” in the “b” cell, and so on. Today savvy font manufacturers use the official Unicode designation for each character. Dingbats and symbols are also used so commonly in multiple languages that the Unicode Consortium assigned these characters their own
positions. This means that, in a Unicode font, familiar dingbat characters might not be accessible via the keyboard letter "n." Access to these characters depends on whether the application manufacturer accommodates the older input method.

When you encounter a Unicode font, use the Character Palette in Mac OS X to select special characters. This type of input method is required for Symbol and Zapf Dingbats characters because they have their own encoding position; it is not necessary for other picture fonts.

For more information about Unicode, visit www.unicode.org.